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TSC2117EVM-K

This user’'s guide describes the operation of the TSC2117EVM-K evaluation module (EVM). The EVM
features a TSC2117 touch screen controller with stereo audio codec, amplifiers for speakers and
headphones and a digital signal processing module. Together with the USB-MODEVM board, the
TSC2117 Control Software and a PC running Windows™ XP it is a plug-and-play solution to evaluate the
capabilities of the TSC2117.

The information in a caution or a warning is provided for your protection. Read each caution and warning

carefully.
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1.2

13

EVM Overview

Introduction

The TSC2117EVM-K features a TSC2117 touch screen controller with stereo audio codec, amplifiers for
speakers and headphones and a digital signal processing module.

Together with the USB-MODEVM board, the TSC2117 Control Software and a PC running Windows XP, it
is a plug-and-play solution to evaluate the capabilities of the TSC2117.

The USB-MODEVM board contains a TAS1020B streaming audio USB controller, which enumerates as a
USB audio class device.

When the USB-MODEVM + TSC2117 EVM is connected to a PC running Microsoft Windows XP, it will be
recognized as a sound card. Once the TSC2117 is configured using the TSC2117 control software, any
audio playback and record software on the PC that uses the Windows audio subsystem (sound card) can
use the TSC2117.

Besides configuration, the TSC2117 control software allows evaluation of the touch screen module of the
TSC2117. The TSC2117 is compatible with 4 wire resistive touch screens (not provided by TI).

Box Contents

The following items ship with the TSC2117EVM-K:
+ TSC2117 EVM
+ USB-MODEVM

The control software required to operate the EVM is available from the TSC2117 product folder at
pttp://www.tl.com

Related Documentation From Texas Instruments
TSC2117 data sheet (EBLAS550)

2

TSC2117EVM-K SLAU282—April 2009
ubmit Documentation Feedbac



http://www.ti.com
http://www-s.ti.com/sc/techlit/SLAS550
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU282

13 TEXAS
INSTRUMENTS

www.ti.com EVM + PC

2 EVM + PC
This chapter explains how to use the TSC2117 EVM with a PC running Windows XP.

2.1 EVM Preparation

To interface the TSC2117 EVM with a PC using USB, plug the TSC2117 EVM onto the USB-MODEVM as
shown in Figure 2 1. TSC2117 EVM + USB MODEVM.

USB-MODEVM J7 UsB

J1 Line In

J4 Touchscreen

J6 Speakers

o
b4
o
2
3

i

)
3
N

Headphones

. TSC2117_RGZ_EVM
J8

Figure 1. TSC2117 EVM + USB MODEVM

Note: USB-MODEVM configuration

To control the TSC2117 from the PC via the USB-MODEVM, set switch SW2 position 1, 3, 4,
5, 6, 7 to ON and position 2 and 8 to OFF.

211 Analog Signal Connections
* Connect a headphone to J8 (3,5 mm jack)
e Connect 8-Q speakers to J6 (4 screw terminal)

— Left speaker to SPLN and SPLP
— Right speaker to SPRN and SPRP
e Connect a line-level audio source to J1 (3,5 mm jack)

2.1.2 Touch Screen Connections

The TSC2117 EVM is compatible with 4-wire resistive touch screens. Connect the touch screen to J4 (X+,
X—=, Y+, Y-).

SLAU282—April 2009 TSC2117EVM-K 3
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2.2 Control Software

The TSC2117 control software exposes most features of the TSC2117 through an intuitive graphical user
interface.

Note: Before Windows on the PC can use the TSC2117EVM-K as a sound card, the TSC2117 on
the EVM must be configured (sampling rate, audio routing, internal amplifier settings etc.)
with the TSC2117 control software.

2.3 Installation

Download the TSC2117 control software (ELAC264) from the TSC2117 product folder at hifp://www.fi.com
and launch the program (GLAC264).

This file is a self-extracting archive. The default target folder is:

C:\Program Files\Texas Instruments\TSC2117
Click the Unzip button to complete the installation.

The TSC2117 control software is now available in the target folder. The name of the executable is
TSC2117.exe

To launch the TSC2117 control software, navigate to the target folder with the Windows Explorer and
double click TSC2117.exe.

2.4 Concepts

The TSC2117 control software presents a block diagram view of the TSC2117 (or select modules within
the TSC2117).

The block diagram consists of active objects that can react to user input (for example switches or
amplifiers with variable gain that show a volume control on a mouse click event).

Note: Each active object will change color to red if the mouse cursor is above the object. Clicking
the object will trigger its function.

Some active objects are linked to control register(s) of the TSC2117 in a two way fashion. If an EVM is
connected, the control software will update the appropriate register(s) whenever an active object is
triggered. If a register that is linked to an active object is changed via other components (for example the
script interpreter or the register inspector), the active object will change its state accordingly.

The control software will automatically detect a TSC2117EVM-K once it is connected to a USB port of the
PC.

If no TSC2117EVM-K is connected to the PC, the control software changes to a simulation mode, where it
is possible to retrieve script commands based on user input within the block diagram.

4 TSC2117EVM-K SLAU282—April 2009
ubmit Documentation Feedbac



www.ti.com\litv\zip\SLAC264
http://www.ti.com
www.ti.com\litv\zip\SLAC264
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU282

13 TEXAS
INSTRUMENTS

www.ti.com EVM + PC
2.5 Main Window
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Figure 2. Main Window

At the top of the main window is a tool bar with buttons to change between four different use cases of the
TSC2117:

. * Full featured TSC2117
. [' Playback only
. B Record only

. Touch Screen only
By default, the control software displays the full featured block diagram of the TSC2117.

Each use case has its own initialization script, which will run if a use case is selected by clicking on one of
the use case buttons. The initialization script contains register settings for the TSC2117 to configure the
device for a specific use case.

The toolbar contains a control that determines the zoom factor. Change the zoom by selecting the desired
zoom factor.

To move the block diagram, click on a blank area within the block diagram and drag the diagram with the
mouse.

At the bottom of the main window is a status bar that provides information about the state of the
communication between the control software and the TSC2117EVM-K. It also shows hints about elements
in the block diagram, for example the 12C page and register / bit location of a selected switch.

Audio signal paths (both digital and analog) will change color from black to

» Blue for left audio output

e Turquoise for right audio output

SLAU282-April 2009 TSC2117EVM-K 5
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2.6

* Magenta for audio input

once they are activated via switches. This feature visualizes all audio paths and immediately highlights if a
path is disabled.

Using Active Objects

Moving the mouse pointer over an active object will light up the active object (the color of the object turns
red).

For example, the Class-A/B HP Driver left amplifier active object will turn from its inactive state to its active
state when the mouse pointer enters the amplifier symbol:

Class-AB HF Driver
0dB to 9dB

—_

N

Class-AB HF Driver
0dE to 9dB

—

™

Clicking the activated object will trigger its function. In the case of the amplifier active object, the function
is a volume control. Moving the volume control slider changes the volume setting of the ampilifier (it is also
possible to change the volume by clicking onto the number within the amplifier symbol and typing the new
gain setting).The control software updates the appropriate register in the TSC2117 and as a result the
volume on the headphone output will change accordingly.

Clas=-A8 HF Driver

0dB to 8dB
g dB
-
|
N

—

L [ Mute
Dialogs and Active Objects
The TSC2117 control software contains several dialog windows that give access to additional features.
Most dialogs are linked to active objects and are opened by clicking on the active object.
A few dialogs are not linked to active objects and are opened using the View menu.
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26.1 Init Script Dialog

Each use case * [) . i , lowns a unique initialization script which will automatically run when a
TSC2117EVM-K is detected or if the user selects another use case.

To show or edit the initialization script, choose View->Init Script... from the main window menu bar.

nit Script: TSC2117_Init.kxt

Command Buffer:

£ TTTTTTTTTTTTTTTTTTTToTToTToT T e = Open
w 30 00 0o
# /W reset
- o1 ESave
# PLL_clkin = MCLE,codec_eclkin = PLL_CLE
w 30 04 03 A
# PLL Power up, P =1, B =1
= 91
# J =8
= 08
# D = 0000, Dil3:8) =0
= 0o
# Di(7:0) =0
= 0o
# mode iz iZs, wordlength is 1&
w 30 1k 00
# NDAC is powered up and set to 4
w 30 Ob 54
# MDAC is powered up and set to 4
= G4
w
£ b

Figure 3. Initialization Script

Click the Run button to run the script again. For further information about the script syntax, see Figure 3.

SLAU282-April 2009 TSC2117EVM-K 7
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2.6.2 Command Dialog
Open the command dialog (View->Command...) to write, edit, load, save and run command scripts.
Command scripts are text files that contain commands to communicate with the TSC2117. The syntax is
described in Figure 4.
Command -
Comrnand Buffer: Read Data:
(= Open | |r 30 28 04:
w30 28 27 17 OF 1D 1D
w30 28 Zf
w 20 Z8 3f HSave
w30 Z8 4f
w 30 28 47 R
w30 Z8 27
w 0 Z8 17 ¥ Record
r 3028 04 Clear
Figure 4. Command Dialog
» The main area of the command dialog is command buffer (editable text) which contains the command
script. To run the command script, click the Run button.
» The smaller read only text area on the right side of the command dialog displays control data read
from the TSC2117. The Clear button clears the Read Data field.
» The one line text edit field on the left bottom allows single command execution.
» The Record check box enables recording of commands generated by the control software.
shows a recording of the volume control for the left Class-A/B HP Driver amplifier (note that the
Record checkbox is checked).
A single command to read four bytes starting at address 0x28 was executed and the result is displayed in
the Read Data field.
8 TSC2117EVM-K SLAU282—April 2009
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2.6.3

Register Inspector

The register inspector dialog (View->Register Inspector...) gives access to all registers of the TSC2117.

Register Inspector

Page: ll—j

Refresh
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|data |data [7 |65 |4 ]3]z |1 [0 ~
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1

[ B e R e ) e R o R

1]

o O O = O O = =
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Figure 5. Register Inspector

The register inspector displays the content of the TSC2117 registers. The control software will read all
TSC2117 registers when a TSC2117EVM-K is detected. To force reading the content of one page, click
the Refresh button.

The Page edit field selects the page to be displayed.

The addr column shows the address of the registers within the selected page in decimal notation.
The description column contains a description for each register. If the register has no function

assigned, it is declared Reserved.

The data columns show the data of each register (one byte). The first data column uses decimal
notation, the second uses hexadecimal notation. It is possible to change the register value by clicking
into one of the data fields and typing the new value (either decimal or hexadecimal).

The numbered columns show the register content in binary notation. Read/Write bits are shown solid
black or red; read only bits are gray or dark red. Red numbers represent bits that recently changed. To
change a single writeable bit, click on the bit and it will flip.

SLAU282-April 2009
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2.6.4 DAC Filter
One of the digital signal processing blocks of the TSC2117 implements five digital biquad filters. The DAC
digital filter dialog (View->DAC Filter...) allows real time graphical manipulation of the digital filters.
The control software will automatically configure the digital signal processing block when the DAC digital
filter dialog is opened.
Digital Filter
!!!- HENI P e
100[Hz] 1000[Hz] 10000[Hz]
Akbenuate Bl B3 B4 BOQS
| = " EQ oy o EQ 5 o EQ | - " EQ
T - £ helfT g _ & Ehein)
£ shelfg STl £ shelfg - shelfB - " ShelfB
R [o5¢ [es 8] || 7+~ [ [4] - [oes 48]
Foc [He] 3 T. [ 1] N TEl S e [
The digital filter dialog limits the range of each digital biquad filter to +/-12[dB] (this is an arbitrary limitation
for demonstration purposes).
Each biquad has its own unique handle with a unique color. Each handle will light up white if the
mouse pointer is in the vicinity, showing that it can be selected. To change the frequency and gain of a
biquad, grab and drag its handle.
It is also possible to change the gain using the slider for each biquad.
Each biquad can be configured for parametric EQ, Shelf Treble or Shelf Bass. If it is configured for EQ,
press the shift key before selecting the handle to adjust the bandwidth of the EQ using the mouse
pointer.
Due to digital range limitations, the biquads will automatically scale, if the biquad coefficients exceed
the limitations.
The coordinate system will shift accordingly to reflect the resulting attenuation.
e To avoid clipping, add additional attenuation with the Attenuate slider.
» To retrieve the biquad coefficients, open the command dialog (see 0) and check Record.
10 TSC2117EVM-K SLAU282—April 2009
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2.6.5 Clock and Digital Signal Routing
The TSC2117 has a flexible and complex clock and digital signal routing architecture.

Two processors can connect to the TSC2117 using two separate I12S™ interfaces: The primary 12S
interface has dedicated pins whereas the secondary 12S interface signals can be assigned to a selection
of pins.

The TSC2117 has an on-chip clock generation module which can be configured to generate the sampling
rate, modulator clocks, converter clocks, bit clock and word clock.

Click on the “Digital Audio Processing Serial Interface” active object (if it is not within the current scope of
the main window, drag the block diagram to the left until the active object appears). This will change the
block diagram to the clock and digital signal routing diagram:

¥ T5C2117 EER
File  Wiew Help
Bht 755
Clock Routing &
Back To Codec
primary BCLK e~
RN § T - - : e -=DAC WCLK
~ -=ADC WCLK
primary DIN S
primary DOUT =DOUT
secondary BCLK Internal Clock Gen Module
LIEY - b
=-DAC F5 (WCLK)
=ADC F5WCLK)
secondany WOLK:
TS
secondary DIN
a =
secondary DOUT-
A -
ADC_WCLK ——=
A, -/

< >
EvM Status: Connected [2C Activity USB Fs = 44100

Figure 6. Clock and Digital Signal Routing

The clock and digital signal routing diagram shows the current state of the TSC2117 routing configuration
and allows interactive manipulation.

e Each clock or signal source has its own unique color. For example, the BCLK signal from the internal
clock generation module has a turquoise color.

e To trace the routing of a specific signal, follow its color. The example in shows that the BCLK
signal from the internal clock generation module is routed to the primary I2C™ BCLK pin (which is
configured as an output), to the secondary 12S BCLK signal (which is not connected to a pin) and to
the BCLK input of the codec (ADC and DAC within the TSC2117).

» To change the definition of a pin (input or output), click the active object (arrow) that belongs to the pin.
Only pins that can change between input and output are linked to such an active object. The clock
routing diagram will automatically change to reflect the new routing.

» Some of the switches within the diagram are active objects, which can be manipulated using the
mouse pointer. Other switches open or close depending on the state of the associated pin.

» To assign a pin to a signal of the secondary I2S interface, choose one of the available pins in the drop
down box that belongs to the signal. The list of available pins will change automatically depending on
the assignment of other signals to pins.

» Click on the “Back To Codec” active object to return to the previous block diagram.

* Click on the “Internal Clock Gen Module” active object to display the digital configuration dialog.

SLAU282-April 2009 TSC2117EVM-K 11
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2.6.6

Digital Configuration

The digital configuration dialog gives access to the codec clock and PLL settings as well as the audio

interface settings.

To open the digital configuration dialog, navigate to the clock and digital signal routing diagram (see
Figure ) and click on the “Internal Clock Gen Module” active object.

Digital Configuration

l Audio Interface ]
Input
Clock Tnpuk: MCLE - Input Freqency:  |12000000 Hz
ADC DAC
Sample Rate: 44100 Hz Sample Rate: Hz
Engine OSR: |4 Engine O5R: |4
Instruckions:  |128 Instruckions: (128
Advanced... [v DAC Fs=aDC Fs
Results
Clock configuration:
PLP | |7 [o  |uapc |mabc|aosk [Fsapc |NDac [MDAC [DOsR |FsDac &
1 1 7 560 3 5 128 44100 3 5 128 44100
on o1 1 7 L2644 4 125 44100 4 4 1258 44100
on 1 1 7 560 5 3 128 44100 3 5 128 44100
on o1 1 7 5264 § 2 125 44100 4 4 1258 44100
on 1 1 7 560 15 1 128 44100 3 5 128 44100
on 1 1 7 5264 16 1 125 44100 4 4 125 44100
on o1 1 7 Q955 17 1 125 44100 17 1 1258 44100
on 1 1 g 4672 6 3 125 44100 & 3 128 44100 ¥

Figure 7. Digital Configuration: Codec Clock / PLL

The digital configuration dialog contains two tabs, one for the Codec Clock / PLL settings and one for the
Audio Interface settings.

The Codec Clock / PLL settings tab (see Figure 7) enables simple generation of PLL and clock divider
settings based on the available input frequency and the desired sample rate:

1. Choose the clock input using the Clock Input drop down box.

2. Type the available input frequency in the Input Frequency edit field.

3. Type the desired sample rate in the Sample Rate edit field of the ADC. By default, the DAC sample
rate equals the ADC sample rate. Uncheck DAC Fs = ADC Fs and enter the DAC sample rate for
different sample rates.

4. The Engine OSR and Instructions fields affect the miniDSP. Please contact your Tl representative for
further information about the miniDSP.

5. The Results list shows all clock settings that fulfill the chosen parameters. Double click on one of the
results to program the TSC2117 with the new settings.

Each result has the following columns:

12
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e PLL: On or Off

e P,R,J,D: PLL configuration
 NADC, MADC: ADC clock dividers
* AOSR: ADC over-sampling factor
* FsADC: ADC sampling rate

« NDAC, MDAC: DAC clock dividers
» DOSR: DAC over-sampling factor
e FsDAC: DAC sampling rate

Click the Advanced... button to show the advanced clock settings dialog.

Input Frequency = 12000000 l
PLL

R ] D
1] x[7 [sen
1
P v Power

CODEC_CLEIN = 84672000 ‘

! I

WA NDAC
3 v Power 3 v Power
l ADC CLK l DAC CLK

MADC MDA
5 v Power 5 v Power

i ADC MOD CLE l DAC MOD CLK

ACSE DSk

s s
l l

ADC Fs = 44100 DACFs= 44100

hdvanced Clock Settings

Intermally generated BCLE

Source:  |DAC_CLE -
Divider: |2 [ Power

[ Inwerk BCLE (primary & secondary)

CLEQUT

Source:  MCLK -
Divider: |2 [ Power

Dest.:  [MfA -

Figure 8. Advanced Clock Settings.

The advanced clock settings dialog gives direct access to the PLL and codec clock dividers. It will
recalculate the clock results dynamically whenever a parameter is changed.

The internally generated bit clock signal (BCLK) can be derived from several sources and divided by an
integer number. Select the desired source with the Source drop down box, choose the divisor and enable

power to the divider, if required.

It is possible to put out a clock signal CLKOUT. Select the clock source, the divider and the destination pin

using the advanced clock settings dialog.

SLAU282-April 2009
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2.6.7 Audio Interface
The Audio Interface tab ( see Figure 9) contains controls to manipulate the digital audio interface:

Digital Configurati
Coder Clock [ PLL
Coder Interface

Format: 125 -

Word Length 16 bits -

[ High Impedance State For DOUT outside of data kransfer

DIN/DOUT offset: (238 BCLEs

Loopback,

[ ADC ko DAC loopback
[w DIM o DOUT loopback

Figure 9. Audio Interface

Use the Format drop down box to change the digital audio interface format:
« 125

« DSP

* Right Justified

* Left Justified

For details about the digital audio interface formats see the TSC2117 data sheet (SLAS550), 5.4 AUDIO
DIGITAL I/O INTERFACE.

The Word Length drop down box defines the number of bits per audio word.

The DIN/DOUT offset defines where the data for the ADC or from the DAC is located in the bit-stream.
This is required for TDM (DSP) interface format.

14 TSC2117EVM-K SLAU282—April 2009
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2.6.8 Touch Screen

The Touch Screen is implemented as an active object in the block diagram for the full TSC2117 ‘and in
the block diagram for touch screen operation L. It is labeled “Touchscreen”.

Once activated, the touch screen active object configures the TSC2117 touch screen module for
Conversion Mode 2 and starts polling the TSC2117 touch screen registers with a period of 50 ms.

The inside of the touch screen active object (rectangle) shows the current coordinates (X and Y) and a
drawing based on touch screen input.

File Wiew Help

BPrtE %~

Touchscreen
¥ = 1088, ¥ = 2067

MACLE

£ ta
E'M Status: Connected 2C Aciivity © USBFs=22050 Touchscreen: Page: 3,

Figure 10. Touch Screen Active Object

To change the touch screen module parameters, click on the touch screen active object. This will display
the touch screen dialog.

To clear the touch screen drawing, open the touch screen dialog and click on the Clear button.

SLAU282—April 2009 TSC2117EVM-K 15
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The results of the SAR ADC data conversions are available in an active object labeled SAR Data within
the block diagram for the full TSC2117 *

Once activated, the SAR data active object configures the TSC2117 touch screen module for Conversion
Mode 9 and starts polling the TSC2117 SAR data registers with a period of 50 ms.

The inside of the SAR data active object (rectangle) shows the conversion results for IN1, IN2, BAT and

TEMP.
¥ TSC2117
Eile Wew Help
@bt E % v
|| -
ADC
WREF
L] SAR Data |
J IM1 = 1.24969 [W]
IM2 = 0.882568 [V] i
BAT = 0.0564575 [V]
TEMP = 27C
-
< >
Evh Status: Connected 12 Aciivity @ USBFs=44100 SAR Data: Page: 3, Register: 0, Length: 70

Figure 11. SAR ADC Data

To change the SAR ADC module parameters, click on the SAR data active object. This will display the
SAR ADC dialog.

16 TSC2117EVM-K SLAU282-April 2009
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2.6.10 AGC
The TSC2117 has an automatic gain control module, which is accessible by an active object labeled AGC
within the block diagram for the full TSC2117 {:I
Clicking on the AGC active objects opens the AGC Dialog:

Target Level: -20de

Moise Threshold:  -66 dB

AGC Gain

|
N

More == |

Figure 12. Automatic Gain Control

If the AGC is enabled, the TSC2117 will adjust the gain of the analog audio input signal amplifier so that
the input signal level for input signal amplitudes above the noise threshold approximates the target level.

e The main display in the AGC dialog shows the Amplitude of the ADC output data in decibel with 0dB
equal to a full scale signal.

— The target level line can be adjusted using the mouse pointer. It will change color to red if it the
mouse pointer is in the vicinity, indicating that it can be moved (click and drag).

— The noise threshold line is also adjustable
e The small display on the left shows the ADC output data

» The AGC Gain field shows the applied gain (if the AGC is enabled) and allows setting a maximum gain
using the slider.

Advanced AGC controls are available by clicking the More button. This will reveal further controls to adjust
various AGC parameters.

SLAU282—April 2009 TSC2117EVM-K 17
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2.6.11

Digital Volume Control and DRC
The TSC2117 has digital volume control and dynamic range compression modules for each DAC channel.
Each is accessible by a active objects labeled DVol within the block diagram for the full TSC2117 i:}and
the playback use case

Clicking on the DVol active object opens the DAC Vol dialog, which contains a slider to set the digital
volume and several options. Checking the DRC option reveals the DRC transfer function.

D
attack: j 4 dBJFrame
Decay: _I\I 4 dBJFrame
Threshald: b j -24 dB
Hysteresis: _I\I 0de
Hald: j 2048/Fs

Figure 13. DRC Transfer Function and DRC Dialog

The horizontal axis of the DRC transfer function shows the input to the DRC and the vertical axis shows
the output of the DRC. The green line shows the gain below the DRC threshold, the magenta colored
horizontal line shows the DRC threshold and the red line shows the gain above the DRC threshold.

The DRC transfer function will change depending on the digital volume setting and the DRC threshold.

Click on the DRC transfer function to reveal the DRC dialog, which contains a slider to change the DRC
threshold.

18
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3 EVM Hardware

This chapter contains information about the EVM Hardware (switches, jumpers, schematics).

3.1 Connectors and Jumpers

Table 1. Analog I/O

Connector Function
Ji MIC/LINE in
J2 1 IN1
2 IN2
3 IN3
4 AGND
J3 1 REF
2 AGND
J5 1 LN (speaker filtered)
2 LP (speaker filtered)
3 RN (speaker filtered)
4 RP (speaker filtered)
J6 1 SPLN (speaker)
2 SPLP (speaker)
3 SPRN (speaker)
4 SPRP (speaker)
J7 1 BATT
2 GND
J8 Headphones
J9 Headphones (filtered)
J10 1 HPL
AGND
3 HPR
Table 2. Touch Screen
Connector Function
J4 1 Y-
2 X—
3 Y+
4 Y-
P11 10 Y-
12 X—
14 Y+
16 Y-
Table 3. GPI
Connector Function
W19 1 GPI1
GPI2
3 GPI3
SLAU282-April 2009 TSC2117EVM-K 19
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Table 4. Jumpers

Jumper Function Positions Default
w1 IOVDD select 1-2: 1.8V 1-2: 1.8V
2-3:3.3V
W9 MIC bias select 1-2: TSC2117 1-2: TSC2117
2-3:3.3V
W10 IN1 select 1-2: ext J2 not populated
2-3: on-board V
w11 IN2 select 1-2: ext J2 not populated
2-3: on-board V
w12 IN3 select 1-2: ext J2 not populated
2-3: on-board V
W13 REF select 1-2: ext J3 not populated
2-3: on-board V
w14 HPL 16 Q load 1-2: add load not populated
W15 HPR 16 Q load 1-2: add load not populated
W16 HPL CAP bypass 1-2: bypass not populated
w17 HPR CAP bypass 1-2: bypass not populated
w18 Firmware select 1-2: select EVM 1-2: select EVM
W19 HPL CAP bypass 1-2: bypass 1-2: TSC2117
2-3: 3.3V
W20 Reset source 1-2: reset from USB-MODEVM not populated
Table 5. Expansion Connectors P12/3J12
Pin Number Signal Description
P12.1/312.1 NC
P12.2/312.2 NC
P12.3/J12.3 SCLK SPI™ Serial Clock
P12.4/312.4 DGND Digital Ground
P12.5/312.5 NC
P12.6/J12.6 NC
P12.7/312.7 Ss SPI Chip Select
P12.8/312.8 NC
P12.9/312.9 NC
P12.10/J12.10 DGND Digital Ground
P12.11/312.11 MOSI SPI MOSI Slave Serial Data Input
P12.12/312.12 NC
P12.13/J12.13 MISO SPI MISO Slave Serial Data Output
P12.14/J12.14 RESET TAS1020B Reset
P12.15/J12.15 NC
P12.16/J12.16 SCL 12C Serial Clock
P12.17/312.17 NC
P12.18/J12.18 DGND Digital Ground
P12.19/J12.19 NC
P12.20/312.20 SDA 12C Serial Data Input/Output

20 TSC2117EVM-K
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Table 6. Expansion Connectors P22/322
Pin Number Signal Description
P22.1/322.1 NC
P22.2/322.2 NC
P22.3/322.3 BCLK Audio Serial Data Bus Bit Clock
P22.4/322.4 DGND Digital Ground
P22.5/322.5 NC
P22.6/322.6 NC
P22.7/322.7 WCLK Audio Serial Data Bus Word Clock
P22.8/322.8 NC
P22.9/322.9 NC
P22.10/J22.10 DGND Digital Ground
P22.11/322.11 DIN Audio Serial Data Bus Data Input
P22.12/322.12 NC
P22.13/J22.13 DOUT Audio Serial Data Bus Data Output
P22.14/322.14 NC
P22.15/J22.15 NC
P22.16/J22.16 NC
P22.17/322.17 MCLK Master Clock Input
P22.18/J22.18 DGND Digital Ground
P22.19/J22.19 NC
P22.20/322.20 NC
Table 7. Power Supply
Pin Number Signal
P23.1/J23.1 NC
P23.2/J23.2 NC
P23.3/J23.3 +5VA
P23.4/323.4 NC
P23.5/323.5 DGND
P23.6/323.6 AGND
P23.7/323.7 +1.8VD
P23.8/323.8 NC
P23.9/J23.9 +3.3VD
P23.10/323.10 +5VD

SLAU282-April 2009
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3.2 EVM Schematics
The schematic diagram for the TSC2117EVM is provided as a reference.
22 TSC2117EVM-K SLAU282 - April 2009
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3.3 EVM Bill of Materials

Qty Value Ref Des Description

4 0 R6, R9, R32, R33 RES 0 Q 1/10W 5% 0603 SMD

4 0 L1, L2, L3, L4 RES 0 Q 1 1/4W 5% 1206 SMD

2 16 R27, R28 RES 16 Q 1W 5% 2512 SMD

1 22 R19 RES 22 Q 1/10W 5% 0603 SMD

2 100 R25, R26 RES 100 Q 1/10W 1% 0603 SMD

4 220 R16, R17, R18, R20 RES 220 Q 1/10W 5% 0603 SMD

1 332 R34 RES 332 Q 1/10W 1% 0603 SMD

4 402 R21- R24 RES 402 Q 1/10W 1% 0603 SMD

1 1.0K R8 RES 1.00 kQ 1/10W 1% 0603 SMD

1 2.2K R7 RES 2.2 kQ 1/10W 5% 0603 SMD

3 2.7K R29, R30, R31 RES 2.7 kQ 1/10W 5% 0603 SMD

1 4.7K R35 RES 4.7 kQ 1/10W 5% 0603 SMD

6 10K R12-R15, R36, R37 RES 10 kQ 1/10W 5% 0603 SMD

1 20K R4 TRIMPOT 20 kQ 4MM TOP ADJ SMD

1 30.1K R5 RES 30.1 kQ 1/10W 1% 0603 SMD

1 49.9K R11 RES 49.9 kQ 1/10W 1% 0603 SMD

1 50K R10 POT 50 kQ 3/8" SQ CERM SL ST

1 56.0K R3 RES 56.0 kQ 1/10W 1% 0603 SMD

3 100K R1, R2, R38 RES 100 kQ1/10W 1% 0603 SMD

4 .022uF C44-C47 CAP CER 0.022 pF 50V X8R 10% 0603
2 .047uF C58, C59 CAP CER 47000 pF 50V X7R 10% 0603
8 0.1uF C4-C11 CAP CER .10UF 6.3V X5R 10% 0402
17 0.1uF C20, C27-C34, C40-C43, | CAP CER 0.1 pF 25V X7R 0603

C52, C60-C62

1 .22uF C26 CAP CER 0.22 pF 16V X7R 10% 0603

1 .33uF C1 CAP CER 0.33 pF 16V X7R 0603

1 2.2uF C39 CAP 2.2 pyF 25V CERAMIC X5R 1210

7 10uF C12-C17, C25 CAP CERAMIC 10 pF 6.3V X5R 0603

2 10uF C2,C3 CAP CERAMIC 10 pF 10V X5R 0805

1 10uF C55 CAP CER 10 pF 16V X5R 20% 1206

2 22uF C18, C19 CAP CER 22 pF 6.3V X5R 20% 0805

8 47uF C35-C38, C53, C54, C56, | CAP CER 47 pF 10V X5R 1210

C57

1 Ul Dual-Output Low-Dropout (LDO) Voltage Regulators

1 u2 2.5V 4ppm/Degrees C, 100uA SOT23-6 Series (Bandgap) Voltage Reference

1 u3 Audio Codec

1 U4 IC SERIAL EEPROM 64K 1.7V 8SOIC

1 us Single 2-Input Positive-AND Gate

1 u6 Dual 2-Input Positive-NAND Gate

1 600 L5 FERRITE CHIP 600 Q 500mA 0805

1 D5 LED THIN 635NM RED DIFF 0805 SMD

1 MK1 Omnidirectional Microphone Cartridge or alternate
2 SW1, sSw2 SWITCH SLIDE SPDT 30V.2A PC MNT
3 Ji, J8, J9 3,5mm Audio Jack, T-R-S, SMD

2 J3,J7 Screw Terminal Block, 2 Position

1 J10 Screw Terminal Block, 3 Position

4 J2, J4-36 Screw Terminal Block, 4 Position

1 P23 10 Pin SMT Plug Header
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Qty Value Ref Des Description

1 J23 10 pin SMT Socket Header

3 P11, P12, P22 20 Pin SMT Plug Header

4 J11, J12, J21, J22 20 pin SMT Socket Header

6 TP1-TP6 TEST POINT PC MULTI PURPOSE BLK

7 W2-w8 Bus Wire (18-22 Gauge)

8 W14- W18, W20-W22 2 Pin Thru-hole Plug Header (Jumper), 0 .1" spacing

7 W1, W9-W13, W19 3 Position Jumper , 0 .1" spacing
24 TSC2117EVM-K SLAU282-April 2009

ubmit Documentation Feedbac



http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU282

13 TEXAS
INSTRUMENTS

www.ti.com Appendix A

Appendix A USB-MODEVM Schematic

The schematic diagram for USB-MODEVM Interface Board is provided as a reference.
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Appendix B USB-MODEVM Bill of Materials

The complete bill of materials for USB-MODEVM Interface Board is provided as a reference.

Table B-1. USB-MODEVM Bill of Materials

Designators Description Manufacturer Mfg. Part Number
R4 10Q 1/10W 5% Chip Resistor Panasonic ERJ-3GEYJ1300V
R10, R11 27.4Q 1/16W 1% Chip Resistor Panasonic ERJ-3EKF27R4V
R20 75Q 1/4W 1% Chip Resistor Panasonic ERJ-14NF75R0U
R19 220Q 1/10W 5% Chip Resistor Panasonic ERJ-3GEYJ221V
R14, R21, R22 390Q 1/10W 5% Chip Resistor Panasonic ERJ-3GEYJ391V
R13 649Q 1/16W 1% Chip Resistor Panasonic ERJ-3EKF6490V
R9 1.5KQ 1/10W 5% Chip Resistor Panasonic ERJ-3GEYJ1352V
R1-R3, R5-R8 2.7KQ 1/10W 5% Chip Resistor Panasonic ERJ-3GEYJ272V
R12 3.09KQ 1/16W 1% Chip Resistor Panasonic ERJ-3EKF3091V
R15, R16 10KQ 1/10W 5% Chip Resistor Panasonic ERJ-3GEYJ1303V
R17, R18 100kQ 1/10W 5%Chip Resistor Panasonic ERJ-3GEYJ1304V
RAL 10KQ 1/8W Octal Isolated Resistor Array CTS Corporation 742C163103JTR
C18, C19 33pF 50V Ceramic Chip Capacitor, +5%, NPO TDK C1608C0G1H330J
C13,C14 47pF 50V Ceramic Chip Capacitor, +5%, NPO TDK C1608C0G1H470J
C20 100pF 50V Ceramic Chip Capacitor, +5%, NPO TDK C1608C0G1H101J
c21 1000pF 50V Ceramic Chip Capacitor, #5%, NPO TDK C1608C0G1H102J
C15 0.1pF 16V Ceramic Chip Capacitor, £10%, X7R TDK C1608X7R1C104K
C16, C17 0.33uF 16V Ceramic Chip Capacitor, +20%, Y5V TDK C1608X5R1C334K
C9-C12, C22-C28 1pF 6.3V Ceramic Chip Capacitor, £10%, X5R TDK C1608X5R0J1305K
C1-C8 10uF 6.3V Ceramic Chip Capacitor, £10%, X5R TDK C3216X5R0J1306K
D1 50V, 1A, Diode MELF SMD Micro Commercial Components DL4001
D2 Yellow Light Emitting Diode Lumex SML-LX0603YW-TR
D3- D7 Green Light Emitting Diode Lumex SML-LX0603GW-TR
D5 Red Light Emitting Diode Lumex SML-LX0603IW-TR
Q1, Q2 N-Channel MOSFET Zetex ZXMNGAO7F
X1 6MHz Crystal SMD Epson MA-505 6.000M-CO
us USB Streaming Controller Texas Instruments TAS1020BPFB
u2 5V LDO Regulator Texas Instruments REG1117-5
U9 3.3V/1.8V Dual Output LDO Regulator Texas Instruments TPS767D318PWP
U3, u4 Quad, 3-State Buffers Texas Instruments SN74LVC125APW
us5-U7 Single IC Buffer Driver with Open Drain o/p Texas Instruments SN74LVC1G07DBVR
u10 Single 3-State Buffer Texas Instruments SN74LVC1G125DBVR
ul 64K 2-Wire Serial EEPROM I°C Microchip 24L.C641/SN

USB-MODEVM PCB Texas Instruments 6463995
TP1-TP6, TP9-TP11 Miniature test point terminal Keystone Electronics 5000
TP7, TP8 Multipurpose test point terminal Keystone Electronics 5011
J7 USB Type B Slave Connector Thru-Hole Mill-Max 897-30-004-90-000000
J13, J2-J5, J8 2-position terminal block On Shore Technology ED555/2DS
J9 2.5mm power connector CUI Stack PJ-102B
J130 BNC connector, female, PC mount AMP/Tyco 414305-1
J131A, J132A, J21A, J22A | 20-pin SMT plug Samtec TSM-110-01-L-DV-P
J131B, J132B, J21B, J22B 20-pin SMT socket Samtec SSW-110-22-F-D-VS-K
J133A, J23A 10-pin SMT plug Samtec TSM-105-01-L-DV-P
J133B, J23B 10-pin SMT socket Samtec SSW-105-22-F-D-VS-K
J6 4-pin double row header (2x2) 0.1" Samtec TSW-102-07-L-D
J134, J135 12-pin double row header (2x6) 0.1" Samtec TSW-106-07-L-D
JMP1-JMP4 2-position jumper, 0.1" spacing Samtec TSW-102-07-L-S

26 USB-MODEVM Bill of Materials
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Appendix B

Table B-1. USB-MODEVM Bill of Materials (continued)

Designators Description Manufacturer Mfg. Part Number
JMP8-JMP14 2-position jumper, 0.1" spacing Samtec TSW-102-07-L-S
JMP5, IMP6 3-position jumper, 0.1" spacing Samtec TSW-103-07-L-S
JMP7 3-position dual row jumper, 0.1" spacing Samtec TSW-103-07-L-D
Swi SMT, half-pitch 2-position switch C&K Division, ITT TDAO2HOSK1
SW2 SMT, half-pitch 8-position switch C&K Division, ITT TDAO8HOSK1
Jumper plug Samtec SNT-100-BK-T
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Appendix C USB-MODEVM Protocol

C.1 USB-MODEVM Protocol

The USB-MODEVM is defined to be a Vendor-Specific class and is identified on the PC system as an
NI-VISA device. Because the TAS1020B has several routines in its ROM which are designed for use with
HID-class devices, HID-like structures are used, even though the USB-MODEVM is not an HID-class
device. Data is passed from the PC to the TAS1020B using the control endpoint.

Data is sent in a HIDSETREPORT (see [Table C-1)).

Table C-1. USB Control Endpoint
HIDSETREPORT Request

Part Value Description

bmRequestType 0x21 00100001

bRequest 0x09 SET_REPORT

wValue 0x00 don't care

windex 0x03 HID interface is index 3

wlLength calculated by host

Data Data packet as described in [[@ble C-3.

The data packet consists of the following bytes, shown in [Table C-2:

Table C-2. Data Packet Configuration

BYTE NUMBER TYPE DESCRIPTION
0 Interface Specifies serial interface and operation. The two values are logically ORed.
Operation:
READ 0x00
WRITE 0x10
Interface:
GPIO 0x08
SPI_16 0x04
I2C_FAST 0x02
12C_STD 0x01
SPI_8 0x00
1 1°C Slave Slave address of 1°C device or MSB of 16-bit reg addr for SPI
Address
2 Length Length of data to write/read (number of bytes)
3 Register address | Address of register for I2C or 8-bit SPI; LSB of 16-bit address for SPI
4..64 Data Up to 60 data bytes could be written at a time. EPO maximum length is 64. The return
packet is limited to 42 bytes, so advise only sending 32 bytes at any one time.

Example usage:
Write two bytes (AA, 55) to device starting at register 5 of an 1°C device with address AO:

[ O]
[ 1]
[ 2]
[ 3]
[ 4]
[ 5]

0Ox11
OxAO0
0x02
0x05
OxAA
0x55

28
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Do the same with a fast mode I1°C device:

[ O]
[ 1]
[ 2]
[ 3]
[ 4]
[ 5]

0x12
OxA0
0x02
0x05
OxAA
0x55

Now with an SPI device which uses an 8-bit register address:

[ O]
[ 1]
[ 2]
[ 3]
[ 4]
[5]

0x10
OxAO0
0x02
0x05
OxAA
0x55

Now, do a 16-bit register address, as found on parts like the TSC2101. Assume the register address
(command word) is 0x10EO:

[ O]
[ 1]
[ 2]
[ 3]
[ 4]
[ 5]

0x14
0x10 - Note: the I°C address now serves as MSB of reg addr.
0x02
OxEQ
OxAA
0x55

In each case, the TAS1020 returns, in an HID interrupt packet, the following:

0]

interface byte | status

status:

(1]

(2]
(3]

[4..60]

REQ ERROR 0x80

| NTF_ERROR 0x40

REQ DONE 0x20

for 12C interfaces, the I°C address as sent

for SPI interfaces, the read back data from SPI line for transmission of the corresponding byte
length as sent

for 1°C interfaces, the reg address as sent

for SPI interfaces, the read back data from SPI line for transmission of the corresponding byte
echo of data packet sent

SLAU282—April 2009 USB-MODEVM Protocol
Eubmit Documentation Feedbacl

29


http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU282

13 TEXAS
INSTRUMENTS

USB-MODEVM Protocol www.ti.com

If the command is sent with no problem, the returning byte [0] is the same as the sent one logically ORed
with 0x20 - in the preceding first example, the returning packet is:

[ O]
[ 1]
[ 2]
[ 3]
[ 4]
[5]

0x31
OxAO0
0x02
0x05
OxAA
0x55

If for some reason the interface fails (for example, the I1°C device does not acknowledge), it comes back

as:

[ O]
[ 1]
[ 2]
[ 3]
[ 4]
[ 5]

0x51 - interface | INTF_ERROR
0xA0
0x02
0x05
OxAA
0x55

If the request is malformed, that is, the interface byte (byte [0]) takes on a value which is not as previously
described, the return packet is:

[ 4]
[ 5]

0x93 - the user sent 0x13, which is not valid, so 0x93 returned
OxAO0
0x02
0x05
OxAA
0x55

The preceding examples used writes. Reading is similar:
Read two bytes from device starting at register 5 of an I°C device with address AO:

[ O]
[ 1]
[ 2]
[3]

0x01
OxAO0
0x02
0x05
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The return packet is:

[ 0] 0x21
[1] 0xA0
[2] 0x02
[3] 0x05
[ 4] OxAA
[ 5] 0x55

assuming that the values written starting at Register 5 were actually written to the device.

GPIO Capability

The USB-MODEVM has seven GPIO lines. Access them by specifying the interface to be 0x08, and then
using the standard format for packets—but addresses are unnecessary. The GPIO lines are mapped into
one byte (see [Table C-3):

Table C-3. GPIO Pin Assignments

Bit 7 6 5 4 3 2 1 0

X | P3.5 \ P3.4 | P3.3 \ P13 | P1.2 P11 P1.0

C3

Example: write P3.5 to a 1, set all others to O:

[0] 0x18 - write, GPIO

[1] 0x00 - this value is ignored
[2] 0x01 - length - ALWAYS a1
[ 3] 0x00 - this value is ignored

[ 4] 0x40 - 01000000

The user can also read back from the GPIO to see the state of the pins. Assume the previous example
was just written to the port pins.

Example: read the GPIO

[0] 0x08 - read, GPIO

[ 1] 0x00 - this value is ignored

[ 2] 0x01 - length - ALWAYS a 1
[ 3] 0x00 - this value is ignored

The return packet is:

[ 0] 0x28
[ 1] 0x00
[2] 0x01
[ 3] 0x00
[ 4] 0x40

Writing Scripts
A script is simply a text file that contains data to send to the serial control buses.

Each line in a script file is one command. No provision is made for extending lines beyond one line, except
for the > command. A line is terminated by a carriage return.

The first character of a line is the command. Commands are:

i Set interface bus to use

r Read from the serial control bus

w  Write to the serial control bus

> Extend repeated write commands to lines below a w
# Comment

b Break

d Delay

f

Wait for Flag

SLAU282—April 2009 USB-MODEVM Protocol 31
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The first command, i, sets the interface to use for the commands to follow. This command must be
followed by one of the following parameters:

i2cstd Standard mode 1°C bus

i2cfast Fast mode I°C bus

spi8 SPI bus with 8-bit register addressing
spil6 SPI bus with 16-bit register addressing
gpio Use the USB-MODEVM GPIO capability

For example, if a fast mode I°C bus is to be used, the script begins with:
i i2cfast

A double quoted string of characters following the b command can be added to provide information to the
user about each breakpoint. When the script is executed, the software's command handler halts as soon
as a breakpoint is detected and displays the string of characters within the double quotes.

The Wait for Flag command, f, reads a specified register and verifies if the bitmap provided with the
command matches the data being read. If the data does not match, the command handler retries for up to
200 times. This feature is useful when switching buffers in parts that support the adaptive filtering mode.
The command f syntax follows:

f [i2c address] [register] [D7][D6][D5][D4][D3][D2][D1i] [ DO]

where 'i2c address' and 'register' are in hexadecimal fornmat
and 'D7' through 'D0' are in binary format with val ues of 0,
1 or X for don't care.

Anything following a comment command # is ignored by the parser, provided that it is on the same line.

The delay command d allows the user to specify a time, in milliseconds, that the script pauses before
proceeding. The delay time is entered in decimal format.

A series of byte values follows either a read or write command. Each byte value is expressed in
hexadecimal, and each byte must be separated by a space. Commands are interpreted and sent to the
TAS1020B by the program using the protocol described in Bection C.1].

The first byte following an r (read) or w (write) command is the I°C slave address of the device (if I1°C is
used) or the first data byte to write (if SPI is used—note that SPI interfaces are not standardized on
protocols, so the meaning of this byte varies with the device being addressed on the SPI bus). The
second byte is the starting register address that data will be written to (again, with 1°C; SPI varies—see
Bection C.7 for additional information about what variations may be necessary for a particular SPI mode).
Following these two bytes are data, if writing; if reading, the third byte value is the number of bytes to
read, (expressed in hexadecimal).

For example, to write the values OXAA 0x55 to an 1°C device with a slave address of 0x30, starting at a
register address of 0x03, the user writes:

#exanpl e script
i i2cfast

w 30 03 AA 55
r 30 03 02

This script begins with a comment, specifies that a fast I°C bus will be used, then writes OXAA 0x55 to the
I2C slave device at address 0x30, writing the values into registers 0x03 and 0x04. The script then reads
back two bytes from the same device starting at register address 0x03. Note that the slave device value
does not change. It is unnecessary to set the R/W bit for 1°C devices in the script; the read or write
commands does that.
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www.ti.com Writing Scripts

If extensive repeated write commands are sent and commenting is desired for a group of bytes, the >
command can be used to extend the bytes to other lines that follow. A usage example for the > command
follows:

#exanmpl e script for '> conmand

i i2cfast

# Wite AA and BB to registers 3 and 4, respectively

w 30 03 AA BB

# Wite CC, DD, EE and FF to registers 5, 6, 7 and 8, respectively
> CC DD EE FF

# Place a coment ed breakpoint

b "AA BB CC DD EE FF was witten, starting at register 3"

# Read back all six registers, starting at register 3

r 30 03 06

The following example demonstrates usage of the Wait for Flag command, f:
#exanpl e script for 'wait for flag' command

i i2cfast

# Switch to Page 44

w 30 00 2C

# Switch buffers

w 30 01 05

# Wait for bit DO to clear. 'x' denotes a don't care.
f 30 01 xxxxxxx0

Any text editor can be used to write these scripts; Jedit is an editor that is highly recommended for general
usage. For more information, go to: htip://www.[edit.org.

Once the script is written, it can be used in the command window by running the program, and then
selecting Open Script File... from the File menu. Locate the script and open it. The script is then displayed
in the command buffer. The user can also edit the script once it is in the buffer and save it by selecting
Save Script File... from the File menu.

Once the script is in the command buffer, it can be executed by pressing the Execute Command Buffer
button. If there are breakpoints in the script, the script executes to that point, and the user is presented
with a dialog box with a button to press to continue executing the script. When ready to proceed, push that
button and the script continues.
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and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

Tl warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI's standard
warranty. Testing and other quality control techniques are used to the extent Tl deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.

Tl assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other Tl intellectual property right relating to any combination, machine, or process in which Tl products or services are used. Information
published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from Tl under the patents or other intellectual property of TI.

Reproduction of Tl information in Tl data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. Tl is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.

Resale of Tl products or services with statements different from or beyond the parameters stated by Tl for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. Tl is not
responsible or liable for any such statements.

Tl products are not authorized for use in safety-critical applications (such as life support) where a failure of the Tl product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
and any use of Tl products in such safety-critical applications, notwithstanding any applications-related information or support that may be
provided by TI. Further, Buyers must fully indemnify Tl and its representatives against any damages arising out of the use of Tl products in
such safety-critical applications.

Tl products are neither designed nor intended for use in military/aerospace applications or environments unless the Tl products are
specifically designated by Tl as military-grade or "enhanced plastic." Only products designated by Tl as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of Tl products which Tl has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.

Tl products are neither designed nor intended for use in automotive applications or environments unless the specific Tl products are
designated by Tl as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:

Products Applications

Amplifiers pmplifier.ti.com Audio [vww.1r.com/audid
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